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PowerRIP 2000 turns your ink jet printer into a PostScript® Level 3 compatible printer. PowerRIP 2000, a software
raster image processor (RIP), reads and interprets PostScript Level 3 and allows your printer to print color raster
images. PostScript is the standard for high quality graphic output. All elements of a document, including text,
graphics, and images are described by the PostScript code. When you print from an application, such as
PageMaker®,  PowerRIP processes the PostScript code and sends the processed image to the printer.

PowerRIP 2000 Features
Note:The available Features are dependent on your printer and version of PowerRIP 2000. Not all Features 

are available on all printers or on all revisions of PowerRIP 2000.

Features Lite Professional Platinum LF LF Platinum

PostScript Level 3 compatible - the professional
world printing standard ✔ ✔ ✔ ✔ ✔

Color Sync support ✔ ✔ ✔ ✔ ✔

Accepts User Defined ICC Profiles ✔ ✔ ✔ ✔

ICC profiles for the printers inks and papers as
well as iProof Systems’ PressProof stock, at all
available resolutions ✔ ✔ ✔ ✔ ✔

User definable spot colors and color calibration
controls ✔ ✔ ✔ ✔

Make Composites from Separations ✔ ✔ ✔ ✔

DCS1and DCS2 support ✔ ✔ ✔ ✔ ✔

Prints Acrobat PDF and EPS files by dropping
into printer queue. ✔ ✔ ✔ ✔ ✔

Override printing options embedded in PostScript
files ✔ ✔ ✔ ✔

Network ready, Server/Client and cross-platform
configurable ✔ ✔ ✔ ✔

SWOP, Euro, and Toyo color simulation for more
accurate offset press proof color matching ✔ ✔ ✔ ✔ ✔

PowerRIP PDF ✔ ✔ ✔ ✔ ✔

PowerRIP TIFF ✔

✔

RGB Warning ✔ ✔ ✔ ✔ ✔

Print to multiple printers ✔ ✔ ✔ ✔

Pantone support ✔ ✔ ✔ ✔

Chapter 1 - Introduction
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Where to Get Help

For helpful hints and troubleshooting guidelines, see
Chapter 11. If you need further assistance, technical
support is available from iProof Systems. When calling
for technical assistance, be ready to identify your sys-
tem and its configuration, the serial number of
PowerRIP 2000, and a description of the problems you
are encountering. It is highly recommended that you
enable the Log Messages option when creating a
PowerRIP printer. The entries in the log will help the
support staff identify PostScript error messages.

iProof Systems Technical Support
iProof Systems Technical Support is available through
phone, fax, mail, e-mail and the Internet. Hours of
operation are 9:00 am to 6:00 pm EST (Monday
through Friday). Your free phone support is limited to
30 days from your first support call. After the 30 days
have expired a service charge of $2.50 (U.S. Dollars)
per minute will be applied (billed to your credit card).
Visa, MasterCard, and American Express are accepted.
We suggest using iProof’s free e-mail support to get a
prompt answer to any questions you may have.

iProof Systems
2401 West Eau Gallie Blvd, Suite 4
Melbourne, FL 32935 USA
Telephone Support: (321) 751-2445
Fax Support: (321) 751-2449

Electronic Support Services
• World Wide Web

iProof Systems’ World Wide Web site is 
http://www.iproofsystems.com. iProof Systems’
home page includes FAQs (Frequently Asked 
Questions), new product announcements, Error 
Messages, Read Me files, and other helpful
information.

• iProof Systems E-Mail Support
You can also send e-mail to iProof Systems at 
Support@iProofSystems.com. Please include your 
name, PowerRIP 2000 serial number, platform, and 
printer model so that iProof Systems technical sup-
port representatives can e-mail a response to your 
question.
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Installing PowerRIP 2000 Software (Server/Standalone)

Note: The installation procedure and dialogs displayed are predicated on the printer you are installing, revision of
PowerRIP 2000, and your Operating System. Not all features are available on all printers or on all revi-
sions of PowerRIP 2000.

1. Turn on your computer. If it is already on, check 
the TaskBar to make sure that you have no appli -
cations running. If you do, exit them.

2. Insert the PowerRIP 2000 CD into your CD-ROM 
drive. If auto-play is enabled, the PowerRIP 2000 
Install splash screen will appear. If the splash 
screen does not appear, open My Computer on 
your Windows Desktop, then open the CD-ROM. 
Double-click on the file named “Setup.exe.” Click 
once on PowerRIP 2000.

3. The Choose Setup Language dialog will display. 
This dialog defaults to English. Select your lan-
guage. Click OK.

4. The Install Shield Wizard dialog will display 
momentarily.

5. The Select Location dialog will display. This dia-
log defaults to US English (default page size 
Letter). Click Continue.

6. The Please Select Version dialog will display.

Select the revision of PowerRIP 2000 that you 
wish to install. 
Note: The gold seal on the PowerRIP 2000 CD 

sleeve will tell you which revision on 
PowerRIP 2000 you have.

Click Continue.
7. The Welcome dialog will display. Click Next.

8. The Software License Agreement dialog will dis-
play. Click Yes.

9. The Select Components dialog will display. You 
must select the components (printers) you wish to 
install.

Chapter 2 - Installing PowerRIP 2000
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13. A dialog will display telling you the printer has 
been installed. Click OK.

14. A dialog will display telling you that PowerPDF 
has been installed. Click OK.

15. The Setup Complete dialog will display. Click 
Finish.

You have completed the PowerRIP 2000 software
installation. You must now validate your PowerRIP
2000. If you do not validate PowerRIP 2000 PowerRIP
will print across the page. Continue with validating
PowerRIP 2000 (page 10).

Modify, Remove or Repair PowerRIP 2000

Modify
Modify should be used to:

• Add additional new printers (program compo-
nents) to PowerRIP 2000.

• Remove previously installed printers (program 
components) from PowerRIP 2000.

1. Follow steps 1,2,3 and 4 page 6, Installing 
PowerRIP 2000.

2. The Modify, repair, or remove the program dia-
log will display. Select Modify. Click Next.

3. The Please Select Version dialog will display.

Select the revision of PowerRIP 2000 that you 
wish to install. 
Note: The gold seal on the PowerRIP 2000 CD 

sleeve will tell you which revision of 
PowerRIP 2000 you have.

Click Continue.

If you wish to change the 
destination folder click 
Browse. The Choose 
Folder dialog will display. 
Type the correct path. Click
OK. The Select 
Component dialog will 
redisplay. Click Next.

10. The Select Program Folder dialog will display. 
Click Next.

11. The PowerRIP 2000 Setup dialog will display 
and PowerRIP 2000 will start installing.
Note:There could be a slight pause on the 

progress bar while the software is installing.

12. The Print Manager Setup dialog will display. 
The printer you selected in the Select Component 
dialog should be highlighted. Click Continue.



PowerRIP 2000 ManualiProof Systems, Inc. 8

4. The Select Components dialog will display.

If you wish to add an additional new printer to the 
PowerRIP 2000, but not remove previous print-
er(s), make sure you select both the new and 
previous printer(s) in the Select Components
dialog.

If you have more then one printer installed and 
wish to remove one of the printers, select the print-
er that you want to keep and deselect the printer 
you wish to remove. Click Next.

5. After the components have been added or deleted 
the Maintenance Complete dialog will display. 
Click Finish. The PowerRIP 2000 splash screen 
will redisplay. Click Exit.

Repair
Repair should be used:

• If you wish to reinstall all the program components 
previously installed.

1. Follow steps 1,2,3 and 4 page 6, Installing 
PowerRIP 2000.

2. The Modify, repair, or remove the program dia-
log will display. Select Repair. Click Next.

3. The Select Location dialog will display. Click 
Continue.

4. The Please Select Version dialog will display. 
Select the revision of PowerRIP 2000 that you 
wish to install. 

Note: The gold seal on the PowerRIP 2000 CD 
sleeve will tell you which revision of 
PowerRIP 2000 you have.

Click  Continue.

5. The PowerRIP 2000 Setup dialog will display and
PowerRIP will start reinstalling.

6. The Print Manager dialog will display. Select 

your printer and click  Continue. A dialog will 
display asking you if you wish to update the driver
for each printer you have installed. Click Yes
and/or OK. The PowerRIP Setup dialog will dis-
play. Click Finish.

Remove
Remove should be used to:

• Remove all installed PowerRIP 2000 components 
(printers).

• Remove a previous revision of PowerRIP 2000
before installing a new revision.

Note: If you have customized files such as ICC profiles 
or calibration curves saved in the PRPC2000 
folder, you should move them to another folder 
for safe keeping. If they are not moved they will 
be removed along with PowerRIP 2000 during 
the remove function.

1. Follow steps 1,2,3 and 4 page 6, Installing 
PowerRIP 2000.

2. The Modify, repair, or remove the program dia-
log will display. Select Repair. Click Next.

3. The Confirm File Deletion dialog will display. It 
will as ask you Do you want to completely remove 
the selected application and all of its components?
Click OK.

4. After the components have been uninstalled the 
Maintenance Complete dialog will display. Click 
Finish. The PowerRIP 2000 splash screen will 
redisplay. Click Exit.

Additional Local Printers
If you installed components for more then one printer
on the initial install of PowerRIP 2000, the Print
Manager will install only one of the printer drivers
needed. You will have to use Additional Local Printers
to insert additional printers in the Print Manager.

1. Insert the PowerRIP 2000 CD into your CD-ROM 
drive. The splash screen will appear. Click 
Additional Local Printer. The PowerRIP Print 
Manager Setup dialog will display.

2. Highlight the printer you wish to install. Click 
Continue. A dialog will display telling you that 
the driver has been installed. Click OK.
Go to Start>Settings>Printers and you will see 
the driver you just installed.
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Installing PowerRIP 2000 Software (Client)

Drivers for Remote Workstations
Drivers for Remote Workstations gives you the ability
to create PowerRIP 2000 Remote Printer Queues for
workstations on the network. If you are on a large net-
work, Remote Printer Queues will give you the ability
to expedite your workflow, faster throughput speeds,
and the ability to print to more then one printer on the
network. Using Drivers for Remote Workstations you
will be creating a PowerRIP 2000 server/client relation-
ship.

Select one of your workstations to be your PowerRIP
2000 server. This workstation should have enough
RAM and free hard drive space to meet the printing
needs for all the workstations on the network. As an
example; if you have 10 workstations on the network,
all sending files to the PowerRIP 2000 server, you will
need enough free hard drive space to accommodate the
potential of 10 files, from 10 workstations sitting in the
queue waiting for their turn to print.

Server Workstation
1. Install the PowerRIP 2000 software following the 

Server/Standalone directions on page 6.

2. Validate PowerRIP 2000 following the directions 
on page 10. 
Note: Only the PowerRIP 2000 server is validated.

You do not validate the client workstations.

3. Share the printer. Go to Start>Settings>Printers. 
Highlight your printer and then go File> 
Properties. In the Properties dialog go to the 
Sharing tab. Select Shared As or Shared depend-
ing on the operating system you are using. Close 
the properties dialog. Your printer is now available 
over the network.

Client Workstations
Note: The following install instructions should be done 

on each client workstation on the network that is 
going to print to PowerRIP 2000.

1. Turn on your computer. If it is already on, check 
the TaskBar to make sure that you have no appli-
cations running. If you do, exit them.

2. Insert the PowerRIP 2000 CD into your CD-ROM 
drive. If auto-play is enabled, the PowerRIP 2000 
Install splash screen will appear. If the splash 
screen does not appear, open My Computer on 
your Windows Desktop, then open the CD-ROM. 
Double click on the file named “Setup.exe.” Click 
on Drivers for Remote Workstations.

3. The Connect to Remote PowerRIP dialog will 
display. Highlight the Print Server you wish to 
print to in the Print Server portion of the dialog.

4. Select the PowerRIP in the Shared Printers por-
tion of the dialog. Click Connect.

5. The Select Printer Type dialog will display. Select
the driver you wish to load. Click Continue.

6. When finished Printer Connection Added will 
display. Click OK. Click Done. Go to Start> 
Settings>Printers. You will see the remote printer 
queue that you have just created. It will say 
PowerRIP (name of the printer) on (name of the 
server).

On your client workstation you will create your files
selecting the Remote Queue name in the Page Setup.
When you print, the file will process, spool to the server
and print. If PowerRIP 2000 is installed on the startup
drive, on the server, and has not been launched, the first
file sent to the server will launch PowerRIP 2000. If
PowerRIP 2000 is not installed on the startup drive then
you will have to manually launch.

If you have more than one printer on the network and
want to make a Remote Printer Queue for each printer,
one printer can use PowerRIP PowerRIP Port. The sec-
ond printer should use LPT1, and so on.

Print Manager Queue Scanners
The Print Manager Queue Scanners give you the ability
to scan the queues within PowerRIP 2000 and gives you
the ability to customize your Remote Queues to meet
your specific printing needs.

Note: It is assumed that PowerRIP 2000 is launched 
and maximized and that PowerRIP 2000 is on 
the screen.

1. Go to Inputs>Print Manager Queue Scanners. 
The Configure Print Manager Scanners dialog 
will display. Click Scan. The network will be 
scanned and will display on the printer queues on 
the left side of the dialog in the Print Manager
Queues section of the dialog. Highlight the printer 
queue you wish to customize.

Using Use Calibration and Specify Settings you 
have the ability to customize your printer queue for
your specific needs. (For calibration directions see 
Chapter 7. For directions on Specify Settings see 
Chapter 10.)
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Uninstalling PowerRIP 2000
If you wish to remove a previously installed revision of
PowerRIP 2000 and replace it with a new revision, you
should use Uninstall. Uninstall will retain the integrity
of your validation while removing the previous revi-
sions components.

Go to Start>Programs>PowerRIP 2000 Epson>
Uninstall. the Install Shield Wizard will display
momentarily. Then the following warning will display.
This will remove PowerRIP 2000 Epson from your
computer. Do you wish to proceed? Click OK. When
finished removing the following message will display.
PowerRIP 2000 Epson has been successfully unin-
stalled from your machine. Click OK.

Validating PowerRIP 2000
Before using PowerRIP 2000 you must validate your
copy of the software on your standalone or server
workstation. If you do not validate your copy of
PowerRIP 2000 PowerRIP or Demo will print across
your output. You do not need to validate the client
workstation. Follow the directions below to validate
your PowerRIP 2000 software.

1. Got to Start>Programs >PowerRIP 2000 to 
launch PowerRIP 2000.

2. Click PowerRIP 2000 on the TaskBar to maxi-
mize the PowerRIP 2000 Control Panel.

3. Pull down the File menu and select Install 
Validation. The PowerRIP 2000 Validation dia-
log will display.

4. Write down your unique 
User Code as it appears 
in the dialog similar to 
this dialog.

5. You will also need your 
Product Code which 
can be found on the 
Product ID card inside 
the software package.

6. To obtain your Activation Code, launch your web
browser and enter 
http://www.iproofsystem.com. 
Click on Product Registration. The Online 
Registration and Validation page will display. Fill 
out your registration information and then click 
Submit Form.

7. The PowerRIP 2000 Online Validation web page 
will display. Click Validate PowerRIP 2000.

8. The Validation page will appear. Enter your 
Product Code and User Code then click Submit.

9. Your Activation Code will appear on the next 
screen. Write down that code and quit your 
browser.

10. Enter the Validation Code in the PowerRIP 2000 
Validation dialog Activation box and click OK.

PowerRIP 2000 is now Validated. If you pull down 
the PowerRIP 2000 File menu you will note that Install
Validation is now grayed out and Remove Validation is
active.

Note: The Install Validation process allows up to five 
validations. When you install PowerRIP 2000 for
the first time, and Install Validation the number 
of available validations will be reset to four. 
When you Remove Validation, the counter is 
reset back to five. There is no limit to the amount 
of times you may Install Validation, providing 
you remove validation first. You may also check 
your remaining validations on the iProofSystems 
validation web page

If you do not remember to put your validation 
back in your WEB account when you do a 
remove validation you will loose that validation. 
If you loose all 5 validations you will have to call
the iProof System sales department for additional
validations. There will be a charge for the addi-
tional validations.

Remove Validation
You should Remove Validation before reformatting your
hard drive, upgrading your operating system, or upgrad-
ing to a newer computer.

To Remove Validation follow the steps below:
1. Launch PowerRIP 2000 and maximize PowerRIP

2000.

2. Pull down the File menu and select Remove 
Validation.
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3. You will get a warning message that removing 
validation will result in PowerRIP being printed on
all further output. Click OK.

4. You will get a message which will include your 
invalidation (remove) code. Write down your 
invalidation (Remove) code.

5. Launch your web browser and enter:
http://www.iproofsystems.com

Click on Product Registration. The Online 
Registration and Validation page will display. Fill 
out your registration form and then click Submit 
Form. Click Remove a Validation. Enter your 
Product Code and your Invalidation/Remove code. 
Click  Submit. A dialog will display that confirms 
that you have reset your counter back to 5. It 
should be noted that the counter will be increment-
ed by 1. Thus if you have used 1 validation it will 
be incremented to 5. If you have used 3 validations
it would be incremented to 4 and so on.

Testing PowerRIP 2000
Now that PowerRIP 2000 has been installed, and vali-
dated, you can print a sample pre-made PostScript file
to test the system. This test will only verify that the
PowerRIP 2000 will process and send PostScript jobs to
the printer. It does not test applications sending jobs to
the PowerRIP 2000 queue. Follow the steps below.

1. Launch PowerRIP 2000. Maximize PowerRIP
2000 to open the Main Control dialog. Go to 
File>Print PostScript File. The Open dialog will 
display.

2. Navigate to the PowerRIP 2000 folder on your 
hard drive. Open the folder.

3. Highlight Train.ps. Click Open.

4. The Configure Document Specs dialog will dis-
play. Make sure the proper printer is selected in 
the pull-down menu under Destination Device, and
the proper port is also selected. Click on the Use 
Document Default Settings button, then click 
OK. PowerRIP 2000 will start processing the job 
and send it to the printer queue BGXXx and then 
to the printer.
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Printing to PowerRIP 2000 from most Windows appli-
cations is simple. Select the PowerRIP 2000 printer in
the print dialog of your applications, select settings for
resolution, paper type, etc., and click Print. The appli-
cation builds the PostScript file in the directory that the
PowerRIP 2000 printer specifies. PowerRIP 2000
processes that file and then sends the raster image data
to the queue printer “BGXXx”, which in turn sends it
through the corresponding LPT, network or similar
port.

This section will show you the basics of printing to
PowerRIP 2000. For an in-depth discussion of printing
from applications such as QuarkXPress, PageMaker
etc., refer to the Read Mes on the iProof Systems web
site and/or on your  PowerRIP 2000 CD. These files are
all in Acrobat PDF format. You must have Acrobat
Reader installed on your computer to view these files.
For this discussion WordPad will be used since it is
generally found on most Windows systems.

Printing from stand-alone workstation
running Windows 2000

Note: It is assumed that a WordPad file is on the screen
and ready to be printed.

1. Go to File>Print. The Print dialog will display.

2. General tab
Select your PowerRIP printer in the Select Printer
portion of the dialog.

3. Layout tab
Select the appropriate orientation.

4. Paper/Quality tab
Click the Advanced button.
The Advanced Options dialog will display. 

Note: The available options are dependent on your
printer.  Not all options are available on all 
printers.

Advanced Options allows you to select a variety of
options for printing. A complete discussion of all
the options can be found in Chapter 9.
Select the appropriate Resolution or Print Mode
and Paper Type. If a resolution has xx

x

next to it,
then that resolution is not available for the current
features selected in Advanced Options.

Click OK. Click Print.

PowerRIP 2000 will automatically launch and start
processing the file if it is installed on the startup
drive. If PowerRIP 2000 is installed on a drive
other than the startup drive, you will have to manu-
ally launch PowerRIP 2000. 

Printing from stand-alone workstation
running Windows 98

Note: It is assumed that a WordPad file is on the screen
and ready to be printed.

1. Go to File>Print. The Print dialog will display. In
the printer Name field select your printer.

2. Click Properties

Note: The available properties are dependent on 
your printer.  Not all properties are avail-
able on all printers.

The PowerRIP 2000 Properties dialog will dis-
play. This dialog allows you to select a variety of
options for printing. A complete discussion of all
the options can be found in Chapter 9.

3. Paper tab
Select the appropriate Paper Size and Orientation.

4. Graphic tab
For those printers that use Print Mode skip step 4
and proceed to step 5.
Select the appropriate Resolution. If a resolution
has x

x

next to it, then that resolution is not avail-
able for the current features selected.

5. Device Options Tab
Device Options allows you to select a variety of
options for printing. A complete discussion of all
the options can be found in Chapter 9.
Select the appropriate Paper Type and Print
Mode.
Click OK. Click OK. 

PowerRIP 2000 will automatically launch and start
processing the file if it is installed on the startup
drive. If PowerRIP 2000 is installed on a drive
other then the startup drive, you will have to manu-
ally launch PowerRIP 2000.

Chapter 3 - Printing to PowerRIP 2000
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Printing from stand-alone workstation
running Windows NT 4

Note: It is assumed that a WordPad file is on the screen
and ready to be printed.

1. Go to File>Print. The Print dialog will display. In
the printer Name field select your printer.

2. Click Properties.

Note: The available properties are dependent on 
your printer.  Not all properties are available
on all printers

The PowerRIP 2000 Properties dialog will dis-
play. This dialog allows you to select a variety of
options for printing. A complete discussion of all
the options can be found in Chapter 9.

3. Page Setup tab
Select the appropriate orientation.

4. Advanced tab
Select the appropriate Paper Size. Select the appro-
priate Resolution or Print Mode depending on
your printer.
Click OK. Click OK.

PowerRIP 2000 will automatically launch and start
processing the file if it is installed on the startup
drive. If PowerRIP 2000 is installed on a drive
other then the startup drive, you will have to manu-
ally launch PowerRIP 2000.

Printing from a Macintosh Client to a
PowerRIP 2000 PC Server
To print from a Macintosh client to a Windows
PowerRIP 2000 server you must be running under
Windows NT Server 4.0 with Services for Mac
installed or Windows 2000 Server.

Installing PC PPDs on the Macintosh

Note: For the purpose of this discussion it is assumed:

1. That PowerRIP 2000 is installed on the PC server.

2. The PC will hence forth be considered the Server
for this discussion.

3. That the Macintosh and PC are on a network and
that the Macintosh can see the PC in the Chooser.

4. The Macintosh will hence forth be considered the
client for this discussion.

If you are going to print to a PC server from a 
Macintosh client you must copy the appropriate 
Windows PPD to the Macintosh. If you are using 
an NT server, Services for Mac must be installed. 
When PowerRIP 2000 is installed on your hard 
drive a folder called PPD is also installed in that 
folder. To copy the Windows PPD to your 
Macintosh Operating System do the following:

1. Go to your Chooser.

2. Highlight AppleShare. The name of your PC serv-
er should display on the right side of the Chooser
dialog under Select a file server:

Note: If you cannot see the server then you can go 
no further. Check your network to discover 
why you cannot see the server. Check to 
make sure you have rights to access the serv-
er. If the server is an NT system make sure 
that Services for Mac have been installed.

3. Highlight the server name.
Click OK.

4. The Connect to File Server dialog will display.
Select Registered User. Type the appropriate
Name and Password if applicable.
Click Connect.

5. A dialog will display allowing you to select the
drive that PowerRIP 2000 is installed on.
Highlight the drive and click OK. Close the
Chooser. The drive you selected will be mounted
on the Macintosh desktop.

6. Open the PC hard drive mounted on your
Macintosh. Navigate to the PowerRIP 2000 folder
and open it. Open the PPD folder. Highlight the
appropriate PPD for your printer.  Note: Do not
select the SPD.

7. Go to Edit and select Copy.

8. Go to your Macintosh System Folder>
Extensions>Printer Descriptions. Open the
Printer Descriptions folder. Do an Edit> Paste.
The PC PPD will copy to your Printer Description
folder.

You are now ready to print from the Macintosh client to
the PC server. You can use either LaserWriter or
AdobePS to Print to the server.
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Printing from a Macintosh Client to Windows NT
Server 4.0 or Windows 2000 Server

Note: For this discussion we will be using the 
LaserWriter driver. The same directions 
apply for AdobePS.

1. Go to the Chooser and highlight LaserWriter.
Click Create. Create will display the first time 
you go to the Chooser. Setup will display there-
after.

2. The LaserWriter dialog will display. Click Select
PPD.

3. In the Choose a File dialog make sure that you are
in the Printer Descriptions folder. Select the PPD
that you copied from the PowerRIP 2000 to your
Printer Descriptions folder. Click Choose.
Click OK
Close the Chooser. 
You are now ready to print from your Macintosh
applications. 

For directions for printing from specific applica-
tions refer to the iProof Systems web site and/or
your PowerRIP 2000 CD for the appropriate
ReadMe for the application you are printing from.

Print to File
Any application that sends header information along
with the PostScript file will cause PostScript errors
unless you Print to File. FreeHand is such an applica-
tion. FreeHand sends header information along with the
PostScript file when the print command is executed.
This creates various PostScript errors. Print to File cir-
cumvents this header information and allows you to
print FreeHand files to your printer. For ease of opera-
tion create a new folder on your hard drive to house
your PostScript files. Follow the directions below to
Print to File. 

For this discussion FreeHand will be used and it is
assumed that a FreeHand file is on the screen and ready
to be printed.

1. Got to File>Print.

2. Select your printer in the Printer field.

3. Select Print to File.
4. Select Use PPD.The Select PPD dialog will dis-

play. Navigate to the PPD folder in the PowerRIP
2000 folder on your hard drive. Highlight the PPD
for your printer and click Open.

If the select PPD dialog does not automatically
open, click on the box with the 3 dots to the right
of Use PPD and then navigate to PPD folder and
select the appropriate PPD.

Note: Do not select the SPD. 

5. Click Properties.

Note: If using Windows 2000 click the Advanced 
button.

Select the properties that are appropriate for your
printing needs.
Click OK. 
Click OK
(If using Windows 2000 Click OK a 3rd time.)

6. The Print to File dialog will display. Navigate to
the folder you wish to save your PostScript file in.
Click Save.

7. Launch PowerRIP 2000

8. Go to File>Print PostScript File.

9. Navigate to the folder that you have saved your
file in. Highlight the file you wish to print. 
Click Open.

10. Select Use Document Default Settings. 
Click OK.
The file will process and print.

Cancelling a Print Job
Should it become necessary for you to cancel a job
before it prints or after it has begun, there are two
options:

• You can cancel a job in PowerRIP 2000’s Main 
Control dialog by clicking Cancel on the right side of 
the Progress bar.

• You can cancel a job by opening the Print Manager
for the BGXXx printer, right-clicking on the job, 
and selecting Cancel Job or Purge Jobs. The 
BGXXx printer queue can be opened by going to 
Start>Settings>Printers.
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PowerRIP PDF is the ideal utility for creating high
quality, platform independent PDFs. You can take
advantage of all your applications’ various features and
attributes, combined with the feature intensive
PowerRIP 2000, giving you complete flexibility to cre-
ate PDFs that meet your particular needs. These PDFs
being small in size and platform independent can be
viewed on both the Macintosh or PC, can be used as e-
mail attachments, or web site documents, and are
“print-ready” PDFs.

Features
• Creates PDFs using all applications’ document

settings 

• Select the appropriate resolution for your high 
quality needs

• Creates Mirror Images

• Creates composite PDFs from separations 

• Creates separation PDFs from composites 

• Embeds fonts in the PDF 

• Image Compression

• Auto Rotation

• Preserves OPI Comments

• Preserves Overprint Settings

• Color Calibration Control

• Complete Color Management

Requirements
• At least 1 GB of free hard drive space on the

startup drive.

• Optional Adobe Acrobat Reader 3.0 or later to 
view PDFs on PC. Acrobat 4.0 recommended.

PowerRIP PDF Setup
The Setup to create PDFs is as follows:

1. Launch PowerRIP 2000.

2. Go to Inputs/Folder
Scanners. The Folder
Scanner Configuration dialog will display.

3. In Printer Settings
make sure Destination 
Printer is PDF File. 
Click OK.

Note: The installation procedure and dialogs displayed are predicated on the revision of PowerRIP PDF, and 
your Operating System. Not all features are available on all revisions of PowerRIP PDF.

Creating a PDF using PowerRIP PDF
When printing from your application, you will select
PowerRIP PDF as your printer. PowerRIP 2000 will
process the file and create the PDF using the options
you selected in the Properties portion of the Print dia-
log. The PDF will be created and saved in a folder
called PDFOut. PDFOut was created when PowerRIP
2000 was installed. The PDFOut folder can be found in
the DIGIS folder on your hard drive.

Creating a PDF from a PostScript file
Some applications, such as FreeHand, send header
information along with the PostScript file which can
cause PostScript errors unless you Print to File. For this
discussion a file called jacket.ps was created in
FreeHand using Print to File and saved to a folder
called Print.

1. Go to File/Print 
PostScript File. The 
Open dialog box will
display. Highlight the 
PostScript file you want to convert to a PDF. 
Click Open.

2. The Configure Document Specs dialog will dis-
play. In the Printer
pull-down make sure 
that PDF File is selected.

3. Click Specify Settings. 
The PDF File Setup
dialog will display. 
Select the appropriate 
features in the Output, 
Images, Color, Fonts, 
and Separations tabs.

Note: A description of 
all the features in the Output, Images, Color, 
Fonts, and Separation tabs can be found on 
the following pages.

Click OK.

The Configure Document Specs dialog will redis-
play. Click OK. The PostScript file will process and 
the PDF will be saved in the PDFOut folder.

Chapter 4 - PowerRIP PDF
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Specify Settings - Output Tab

Output File Name Job Name.PDF - creates the PDF using the job name. 

File Name.PDF - creates the PDF using the name of the file. 

User Defined - When User Defined is selected User Defined File Name becomes 
active. You can type a file name for the PDF in this area. 

Prompt -  A dialog will display allowing you to type a file name. 

Prompt If File Exits If the file or job name already exists in the PDFOut folder a Choose Another Name 
window will display. Type a new name for the file. 

Auto Rename if File If the file or job name already exists in the PDFOut folder the PDF will be saved with
Exists a number added to the name. (Example: jacket#2.PDF)

Always Overwrite If a file or job name already exists in the PDFOut folder a new file or job of the same 
name will overwrite the previous file.

Output The default output folder is \DIGIS\PDFOut and can be found on the same drive as 
your PowerRIP. If you wish to put the default folder on a different drive click 
Change. The Select PDF Destination Folder dialog will display. Select the drive and
type the path. A PDFGEN dialog will display asking you if you wish to create a new 
directory. Click Yes.

Resolution The available resolutions are 72 x 72, 144 x144, 288 x 288, 300x300, 600x600, 
1200x1200, and 2400 x 2400. It should be noted that selecting a higher resolution can 
significantly increase the PDF file size.

Output Format ASCII Format - allows you to save the PDF in an ASCII format. It should be noted 
that the ASCII Format will create a slightly larger file.
Auto Rotate - rotates a file from portrait to landscape.
Compressed - Compresses text such as books and manuals to create a smaller PDF 
file. Note: The appropriate compression method is one that creates the smallest PDF 
as possible, with the highest possible quality.



Thumbnails Thumbnails are very small page representations that aid the user in navigating 
through multi-page document. Thumbnails are useful for multi-page documents such 
as manuals.

Color Creates a color PDF.

Monochrome Not available at this time.

View File If you select View File the PDF will automatically be opened in Acrobat as soon as 
the PowerPDF finishes creating the PDF.

PowerRIP 2000 ManualiProof Systems, Inc. 17

Output Tab (Cont)
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Specify Settings - Images Tab

Halftone Information - Select Preserve Halftone Information when you want to retains the halftone 
(screening) information

- Select Use Device Dependent Color to use the PowerPDF 2000 color corrected 
information when creating the PDF.

- Select Convert CMYK images to RGB if you want RGB images when the PDF is 
created.

Transfer Function - Remove - will remove the curves in the file when making the PDF. When the PDF 
is opened in Acrobat the change in the file can be seen on the screen.

- Apply - will use the curves in the file when making the PDF. When the PDF is 
opened in Acrobat the change in the file can be seen on the screen.

- Preserve - uses the curves in the file when making the PDF. When the PDF is 
opened in Acrobat the change in the file cannot be seen on the screen.

Under-Color Removal - Remove - removes UCR when creating the PDF.
(UCR) - Preserve - retains the UCR information when creating the PDF.

Image Sub Sampling - None - no sub sampling will occur.
- Subsample - reduces the amount of data in the image to no more than what the PDF

needs.
- Resolution should be defined when doing Average. Select the lowest resolution 

possible. Selecting a high resolution will greatly increase the time it takes to process 
and print the file.

Image Compression - None - no compression will occur.
- JPEG - compression creates a much smaller size because it eliminates data. JPEG 

compression can affect image quality.
- ZIP - compression does not remove data to reduce the file size so it does not affect 

the image quality.

CCITT (Monochrome - CCITT is a compression method for black and white images made by paint pro-
Images Only) grams and any image scanned with an image depth of 1 bit. There is no loss in 

image quality with this compression method.

OPI/Overprint - Preserve OPI Comment - retains the information needed to replace an FPO (For 
Placement Only) image with a high resolution image located on a server that sup-
ports OPI.

- Preserver Overprint Settings - retains the overprint settings in the file being con
verted to a PDF.
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Color Mode Color Mode cannot be deselected. Monochrome not supported in this revision.

Intended PDF Color SRGB-WEB - is the default RGB color space for Windows and the color standard for 
Appearance for the Web.

NTSC-1953 - is the color standard for national TV.

SWOP - The color matching standard that all printing presses and proofing systems 
in the United States are based upon.

Rendering Intent Perceptual - is a rendering intent which compresses the total gamut from one 
device’s color space when one or more of the colors in the original image is out of the
gamut of the destination color space.

Absolute Saturation, Relative Saturation, Relative Colorimetric, and Absolute 
Colorimetric not available in this revision.

CMYK Source Printers Output Profiles. CMYK 1 through 10 should be used for customized CMYK 
Source information only.

RGB Source Monitor Profiles. RGB Source should be set to reflect the monitor used to create the 
image. Use Document Default if none of the available choices apply.

Mirrored Creates a mirror image of the file.

Specify Settings - Color Tab
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Subset Fonts Selected Subset Fonts if you have created a list of fonts in Always Embed These 
Fonts. The subset you have created will always be embedded with the PDF when it is 
created.

Embed All Fonts Select Embed All Fonts to embed all the fonts with the PDF when it is created.

Never Embed These Click Add to type the name of the font you never want embedded with the PDF.
Fonts

Highlight the font you want to delete from the list and click Remove.

Click Clear Sel to delete the selection you had previously made.

Click Save to save the fonts you have defined as never being embedded with the PDF.

Click Load to load the subset of fonts that you do not want embedded with the PDF.

Always Embed Click Add to type the name of the font you always want embedded with the PDF.
These Fonts

Highlight the font you want to delete from the list and click Remove.

Click Clear Sel to delete the selection you had previously made.

Click Save to save the fonts you defined as always being embedded with the PDF.

Click Load to load the fonts that you always want to embed with the PDF.

Specify Settings - Fonts
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Separated Files Select Make Composites to create a composite PDF from separations

When you click on Edit/Define Spot Colors the Spot Color Configuration dialog 
will display. To define a spot color click Add Spot Color. The Add Spot Color dia-
log will display. Define and name the spot color. Click OK. Your new spot color is 
added to the Define Spot Color list.

To delete a spot color from the Define Spot Color list, highlight the color and click 
Delete Spot Color.

Click OK to exit the Edit/Define Spot Color dialog.

Composite Files Select Make Separations to create a separation PDF.

Select All Plates in Black to create a PDF separation with black plates.

Select Mirrored to create a mirrored separation PDF.

Select Negative to create a negative separated PDF.

Edit/Define Spot Colors See page 22, this manual.

Specify Settings - Separations
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Edit/Define Spot Color

When you click
Edit/Define Spot
Color, the Spot
Color Configuration
dialog will display.
This dialog gives you
the ability to Add
Spot Colors and/or
Delete Spot Colors.
You can save your spot colors in CMYK, RGB, or the
LAB color mode. 

Add Spot Color
Type the name of
the spot color in the
Name of Spot
Color to Add por-
tion of the dialog.
Select the appropri-
ate color mode.

CMYK
The CMYK model is based on the light-absorbing qual-
ity of ink printed on paper. Cyan, Magenta, and Yellow
pigment, in theory, combine to absorb all color and cre-
ate black. For that reason these colors are called sub-
tractive colors. But in reality, because of impurities in
the inks, you get a muddy brown. So these inks must be
combined with K (black) to produce a true black.
Combining C, M, Y, and K is called four-color printing
process.

RGB
The RGB model describes the mixing of Red, Green,
and Blue which is called the additive primary colors.
These colors are mixed on the monitor screen when red,

green, and blue phosphors are stimulated at different
intensities. RGB uses 3 colors to reproduce up to 16.7
million colors on-screen.

LAB
The LAB color model is based on the model proposed
by the Commission International d’Eclairage (CIE) in
1931 as an international standard for color measure-
ment. In 1976 this model was refined and named CIE
L*A*B*. The LAB model is designed to be device
dependent. Lab color consists of a luminance or light-
ness (L) component, an A chromatic component from
green to red, and a B component from blue to yellow.

Type the appropriate percentage of CMYK, RGB, or
LAB depending on the color mode you have selected.
Click OK. The name of the spot color you have just
defined will display in the Defined Spot Colors portion
of the dialog. It should be noted that only the spot col-
ors you defined for a specific color model will display
in Defined Spot Colors. If you defined a CMYK and
RGB spot color, you have to select the appropriate
color mode to see the spot colors you defined for it. All
the spot colors you defined for all the color models do
not display in one window.

Delete Spot Color
Highlight the spot color you wish to delete in the
Defined Spot Colors portion of the dialog. Click Delete
Spot Color. Click OK. The spot color will be removed.

Calibration
PowerRIP PDF has the ability to color adjust using the
Q-Curve Calibration feature. This gives the user the
ability to increase or decrease the color intensity. The
user can adjust all colors or each color individually.
Refer to Chapter 7, this manual for an in-depth discus-
sion of calibration.
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Overview
PowerRIP TIFF is ideal for creating high quality, high
resolution TIFF images that are platform independent.
The higher the resolution you select, the higher the
quality the TIFF image becomes. But it also should be
noted that the higher the resolution selected, the bigger
the file, the higher the quality the TIFF becomes. So a
large amount of free hard drive space to accommodate
high quality TIFF images needs to be available.

All the PowerRIP 2000 features are available when
using PowerRIP TIFF including:

• Make Compositions from Separations. 

Note: Not all applications have the capacity to 
create compositions from separations. 
Photoshop, Word, and Excel are examples 
of applications that cannot use this 
feature.

• PowerRIP 2000s High quality color
management

• Compression for ease of portability and storage
• Ability to select a resolution that best suits your 

needs. 
• Ability to create RGB or CMYK TIFFs

Creating TIFF Images
Any application that has the ability to create a
PostScript file can be used to create a TIFF image using
PowerRIP TIFF. The PostScript file will be created by
the application using the applications Print to File fea-
ture and then processed by PowerRIP 2000 to create the
TIFF output.

Creating a TIFF Image using PageMaker 6.5
Note: It is assumed that the images and/or text you 

wish to convert to a TIFF image is on the screen 
and ready to be processed.

1. File>Print
The Print Document dialog will display. 
Select PowerRIP TIFF in the Printer pull-down.
Select PowerRIP TIFF in the PPD pull-down.

2. Click the Features button. The Print Features
dialog will display. Select the features that meet 
your needs. 

Note: Not all features are available on all revisions of  PowerRIP 2000.

For an in-depth discussion of all the PowerRIP
TIFF features see Chapter 9, this document.

3. Click the Color button. The Print Color dialog 
will display. Select Composite.

4. Click the Options button. The Print Options dia-
log will display. Select Normal in the Send Image 
Data pull down. Select Write PostScript to file. 
The file name should display to the left of the 
Browse button.

5.Click the Browse button. The Write PostScript to 
File dialog will display. Navigate to the folder you
wish to save your PostScript file in. Click Save. 
The PostScript file will be saved to the folder you 
indicated.

Chapter 5 - PowerRIP TIFF Available in the Platinum and LF Platinum versions only.

Note: This is a scrollable dialog.
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`6. Launch PowerRIP 2000. The PowerRIP 2000 
Main Control Dialog will display. Go to File> 
Print PostScript file.

The Open dialog will display.

Highlight your PostScript file and click Open.

7. The Configure Document Specs dialog will dis-
play. Select TIFF File in the Printer pull down. 
Click Specify Settings

8. The TIFF File Setup dialog will display. Select 
the appropriate features in the Output tab. See 
page 24 for descriptions of the Output tab
features.

9. Select the appropriate features in the Color tab. 
See page 26 for descriptions of the Color tab
features.

10. Select the appropriate features in the Separation
tab. See page 27 for descriptions of the 
Separation tab.

11. Click OK.
Click OK.
PowerRIP 2000 will process the PostScript file, 
create the TIFF image, save the TIFF image in 
the folder indicated and display the TIFF image if 
you have View File selected.
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TIFF File Setup - Output tab

Output File Name Job Name.TIF - creates the TIFF using the job name. 

File Name.TIF - creates the TIFF using the name of the file. 

User Defined - When User Defined is selected User Defined File Name
becomes active. You can type a file name for the TIFF in this area. 

Prompt -  A dialog will display allowing you to type a file name. 

Prompt if File Exists If the file or job name already exists in the PowerRIP TIFF folder a Choose
Another Name window will display. Type a new name for the file. 

Auto Rename If File Exists If the file or job name already exists in the PowerRIP TIFF folder the TIFF
will be saved with a number added to the name. (Example: jacket10.TIF)

Always Overwrite If a file or job name already exists in the PowerRIP TIFF folder a new file or
job of the same name will overwrite the previous file.

Output The default folder that the TIFF images are saved in in DIGIS\PowerRIP
TIFF. If you wish to save the TIFF images in a folder other then
DIGIS\PowerRIP TIFF click the Change button. The Select TIFF
Destination Folder dialog will display.
Navigate to the folder you want to define as
your default PowerRIP TIFF folder. Click OK.
Output will display the path to the folder you have selected

View File If you select View File the TIFF image will automatically be opened by the
application you designate in your system software as soon as PowerRIP fin-
ishes creating the TIFF image

Resolution The available resolutions are 72, 100, 144, 150, 288, 300, 600, 1200, 1270,
2400, and 2540 dpi. It should be noted that selecting a higher resolution can
significantly increase the TIFF file size.

Compression Use compression to create the smallest TIFF file possible.   

Nesting Select Activate Nesting to turn Nesting on. Select Override job’s nesting set-
tings if you wish to reprint a nested file with a new Destination Media and
Output Reduction. 
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TIFF File Setup - Color tab

Color Mode Select the Color Mode that meets your needs. The available selections are
CMYK Color or RGB Color.

Intended TIFF Color
Appearance

SRGB-WEB - is the default RGB color space for Windows and the color
standard for Appearance for the Web.

NTSC-1953 - is the color standard for national TV.

SWOP - The color matching standard that all printing presses and proofing
systems in the United States are based upon.

CMYK Source Printers Output Profiles. CMYK 1 through 10 should be used for customized
CMYK Source information only.

RGB Source Monitor Profiles. RGB Source should be set to reflect the monitor used to
create the image. Use Document Default if none of the available choices
apply.

Rendering Intent Perceptual - is a rendering intent which compresses the total gamut from
one device’s color space when one or more of the colors in the original
image is out of the gamut of the destination color space.

Absolute Saturation, Relative Saturation, Relative Colorimetric, and
Absolute Colorimetric not available in this revision.

Color Gamut Total range of color that can be reproduced for a particular output. Max
Gamut will simulate all the colors that are necessary to produce a high
quality TIFF image.

SWOP Simulated will simulate the color gamut of the web offset press.

Euro Simulated is the European equivalent to SWOP Simulated.

Mirrored Select Mirrored if you wish to create a mirrored TIFF image.

Negative Select Negative if you wish to create a negative TIFF.   



PowerRIP 2000 ManualiProof Systems, Inc. 27

TIFF File Setup - Separation tab

Edit/Define Spot Colors See page 22, PowerRIP Users Guide for an in-depth discussion of this 
feature.

Composite Files Select Make Separations to create a separation TIFF.

Select All Plates in Black to create a TIFF separation with black plates.

Select Mirrored to create a mirrored separation TIFF.

Select Negative to create a negative separated TIFF.

Separated Files Select Make Composites to create a composite TIFF from separations

When you click on Edit/Define Spot Colors the Spot Color Configuration
dialog will display. To define a spot color click Add Spot Color. The Add
Spot Color dialog will display. Define and name the spot color. Click OK.
Your new spot color is added to the Define Spot Color list.

To delete a spot color from the Define Spot Color list, highlight the color and
click Delete Spot Color.

Click OK to exit the Edit/Define Spot Color dialog
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The nested file can be then converted to a TIFF file
using PowerRIP 2000’s PowerRIP TIFF feature for
inclusion in Web pages among other uses.

All the PowerRIP 2000 features are available when
using Nesting including:

• Make Composites from Separations
• PowerRIP 2000s high quality color management
• Ability to select a resolution that best suits your 

needs.

Note: Not all features are available on all revisions of  PowerRIP 2000.

Overview
Nesting is ideal for combining multiple images and text
on a single page to reduce material cost. PowerRIP
2000’s fast, efficient workflow, ease of operation, and
feature intensive RIP allows you to combine multiple
text pages for proofing. Nesting provides significant
savings in time. As an example, business cards can be
printed on one output page or multiple text pages com-
bined for proofing. PowerRIP 2000’s nesting feature
can be used in conjunction with crops and trapping.

Nesting Features

Nesting

Nesting Output Media Size

Selecting No Nesting will disable this feature.
You can print the page at a percentage of its size by selecting the
appropriate percentage in this pull-down. The selections are Pages
at 100%, 90%, 80%, 75%, 60%, 50%, 40%, 25%, and 15%.
Pages at 100% will print the pages at full size. Pages at 50% will
reduce the page by 50% and so on.

Defines the page size you wish to output your pages on. All page
sizes PowerRIP 2000 supports, for your printer, are available in
this pull-down menu. If you print two 8.5 x 11 pages on an 11 x
17 page you would select Tabloid in this pull-down. The pages
will auto-rotate to make the most efficient use of the available
page size defined in Nesting Output Media Size.

Print Properties
Print properties are accessed from the Print dialog.

RIP Properties
RIP properties are accessed from the Paper Tab in Specify Setting in the Folder Scanners Configuration dialog.

Active Nesting

Override job’s nesting settings

Configure Nesting

Activate Nesting should be selected if you wish to activate
Override job’s nesting setting. 

Allows you to override nesting features defined when the file
was printed. It allows you to define the destination media size
(Nesting Output Media Size) and Output Reduction (Nesting). 

Allows you to define the nesting features if you wish to print a
file that has not been previously nested. It allows you to define
the destination media size (Nesting Output Media Size) and
Output Reduction (Nesting). 

Chapter 6 - Nesting Available in the Platinum and LF Platinum versions only.
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Calibration

What is color and why do I have to calibrate
The science of color can be very complicated if
described using mathematics to describe human vision.
It is much easier to understand color if we use broad
concepts instead of those difficult, complicated mathe-
matical formulas.

The human eye has only three color receptors. These
three color receptors perceive and react to red, green,
and blue (additive primary colors). The human eye is
very much like your scanner, in that it generates signals
for the red, green, and blue parts of the picture. By the
way, for those math wizards these three receptors are
mathematically described as XYZ.

But we don’t usually define color using XYZ. We use
hue, saturation, and brightness. Hue is the color name.
So if we ask for the color red we are asking for the hue.
Saturation describes the strength of the color.
Brightness describes how light or dark the color is.
There are many other things that affect our perception of
color such as what color background the color will be
appearing on. As an example, if you put red on a blue
background it would not look as intense as it would on a
white background.

Another influence on how we perceive color is the way
our eye registers the color values depending on the rela-
tive position of other colors in an image. As an example
dark colors are less noticeable to the eye then light col-
ors.

The type of paper used to output the image can also
influence the look of the color. Different degrees of
whiteness and glossiness will affect how we perceive
(see) color.

And finally, the type of light used to perceive the color
very much affects how we see the color. The contrast
and saturation of the image is very much affected by
the light we use. So if you look at an image in daylight
and then look at it under florescent lights the colors will
look different.

Note: Chapter 7 includes information about ColorSync and Calibration.
The features discussed in Chapter7are dependent on your printer and version of PowerRIP 2000. Not all 
features are available on all printers or on all revisions of PowerRIP 2000.

We can go on and on about the science of color, but the
short and simple of the matter is that the observer, the
light source, the paper, and how the colors are arranged
on the page all affect the final output. Add to that mix the
fact that no two human eyes perceive color the same way
and you have a host of variables that take many books to
explain. So, let’s look at how we can produce good color
that is pleasing to the eye and true to the colors in the
image, as we perceive them. Again, keep in mind that no
two people agree on what is good color. So the following
information is a guide for you to follow to calibrate your
PowerRIP 2000 for your particular needs.

But before we begin, let us explore some of the proper-
ties of color that you will be exposed to when consider-
ing calibration. When printing in color different color
inks are placed on the paper to create an image. So the
ink and paper are very important factors in printing good
color images. But you also need to know which output
color process is best suited for your color images. There
is one basic method used to lay ink on paper. That is
CMYK. But RGB and Spot colors will also need to
addressed in this discussion. So before we begin to cali-
brate, let us understand the difference between  RGB,
CMYK and Spot colors. 

You are going to be looking at the image two ways. On
the screen and on the printed page. The goal is to be able
to predict from the monitor display what the output will
look like. But this is not easy to do. The monitor uses
RGB to display the image. But generally images are out-
put in CMYK. So we want to take an RGB screen image
and output as a CMYK and maintain its color integrity. 

There is no universal printing standards for PC RGB,
CMYK, monitor white, paper white etc. This is particu-
larly apparent when you import an image in one applica-
tion, print it for proofing purposes and then save it as an
EPS. If you import this EPS into a second application,
very often you will see a color shift because the second
application’s color model is slightly different and affect-
ed the images color during output. So it is important that
you take all these factors into account when calibrating
PowerRIP 2000. You want to create a calibration test file
using the application and paper you will be outputting

Chapter 7 - Color Matching
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your images from. You might want to make a number of
calibration files for the different paper types and applica-
tions that you will be using.

RGB color describes the mixing of red, green, and blue
which are called the three additive primary colors.
These three colors are mixed on the monitor screen when
red, green, and blue phosphors are stimulated at different
intensities. When an image is scanned, the scanner cre-
ates three electrical signals. One for red, green, and blue.
These signals each have a digital value. (It should be
noted that there are some high end scanners that have the
ability to transform the RGB into CMYK information.)

Red, green, and blue vary from scanner to scanner and/or
from monitor to monitor. What that means is you can not
define the true color from the RGB colors. Different
monitors have different phosphors or different illumina-
tion. Some screens have a blue tint while others have a
green tint and so on. The printer will give you another
result because the printer uses a combination of color
that is different then the phosphors of the screen. Also, if
you take the same image and scan it on different scan-
ners you will again get different results because different
scanners use different light sources, filters, sensors, sig-
nals, etc. It should be noted that the scanner also needs to
be calibrated to narrow these variables.

CMYK describes the ink colors cyan, magenta, yellow
and black used in four-color printing and are called
process colors. These values are usually related to the
dot percentage in the color separation. There are as many
CMYK systems as there are printing conditions. Also,
there are various combinations of CMYK values since a
color can be defined using various combinations of
CMYK. CMYK values are transformed to RGB values
on the monitor. That means you do not get really accu-
rate color simulation on your monitor.

Spot Colors are used when a certain color match must
occur. A very common mistake when printing using spot
colors it to print process separations. The spot colors will
be converted to percentages of cyan, magenta, yellow
and black and will no longer be an accurate color match.

Gamut or Color gamut are all the color that a device can
produce. It is the range of colors that a color system can
output. Many more colors can be displayed on the screen
then can be printer. When colors on the screen can not be
printed they are out of gamut. If they are out of gamut
they can not be printed. The RGB gamut is much larger

then the CMYK gamut. The RGB gamut consists of any
combination of red, green and blue. The CMYK gamut
consists of only the colors that can be produced with
cyan, magenta, yellow and black. So gamut is the range
of colors that can print using a particular set of inks and
paper.

White Point defines the whiteness and brightness of the
image color at the lightest/whitest point in the image.
The ink, paper, and quality of the scanned image all
affect the quality of the printed color image. The
smoothness of the paper affects the resolution. The con-
trast is affected by the gloss of the paper. The light
source used to view the image all affect the final color
output. 

PowerRIP 2000 Calibration
PowerRIP 2000 has the ability to color adjust using its
Q-Curve Calibration feature.  This gives the user the
ability to increase or decrease the color intensity. The
user can adjust all colors or each color individually. It
should be understood on the outset, that any adjustment
will affect the entire page - including any tints and
images on the page. It will also affect any Pantone color
you have defined in that page. The user can create differ-
ent calibration and/or dot gain curves either on the fly or
saved as printer queue files, for each individual need as
it arises. Saving your calibration printer queue files will
allow you to use these files at any time, whereas chang-
ing calibration on the fly is a temporary measure.
PowerRIP 2000 is calibrated to the manufacturer’s inks
and papers. If you adjust the calibration it will affect that
built in calibration. Since calibration is adjusted in the
Folder Scanner Configuration Setup menu it is wise to
create a folder on your hard drive called calibration.

Before you create your customized calibration files you
should save the default settings so you can go back to
them when creating additional customized calibration
files. Make sure you select All Same and name the file
Basic. The calibration file Basic will consist of the stan-
dard setup for the manufacturers’ inks and papers. The
customized calibration files will reflect your color
adjustment. This will give you the versatility of using the
PowerRIP 2000 preset color adjustment or your person-
alized color adjustments simply by printing using the
appropriate calibration file.

Since you can create different files that can be attached
to specific queues as well as customized calibration files
for each paper type, resolution and printer, it is easier to
always work from the same basic calibration file.



It should be noted that deselecting use Calibration in the
Folder Scanner Configuration dialog will disable the cus-
tomized calibration file. Your files will then be printed
with the PowerRIP 2000 default settings.

Output Calibration

NOTE: It is highly recommended that a densitometer 
be used when calibrating the PowerRIP 2000.
Though you can calibrate without a densitome-
ter you will be relying on the human eye, light 
source, etc., which as we discussed earlier can 
have many variables.

Calibration to increases or decreases the color intensity
of your output. The intensity of the color can be defined
as the color saturation. When a color becomes less satu-
rated it becomes dull. More saturated it becomes brighter.
So Calibration should be used to increase the intensity or
brightness of the image.

When you select
Output calibration
in the Folder
Scanners
Configuration dia-
log the Q-Curve
5.0 dialog will
display.  The Cyan
channel will be
active. To adjust
all colors, pull down the arrow in the Channel Box and
choose either cyan, magenta, yellow, or black. Or you
can select All Same. All Same would cause all four col-
ors to be adjusted to the curve that appears on the screen.

You must
remember when
working with
Output
Calibration the
higher the
number the
lighter your
output will
print. 

As an example, the 50% box represents the 50% dot
area. If you type 80 in the 50% box your image will print
lighter, less saturated.
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If you type 30 in
that box your
image will print
darker, more
saturated.

Or you can grab
the curve with
your cursor and
move the curve.
Notice when moving the curve that surrounding percent-
ages are also adjusted to blend properly.

When ink is placed on paper the dot spreads, hence dot
gain. The characteristics of the paper, the percentage of
ink used and even the order colors are placed on the page
can affect dot gain. The critical area where your dot gain
decisions should be made are in the midtones of your
image. Adjusting the midtones should create an overall
pleasing color image. If you adjust the highlights and
shadows the midtones will change and will create an
unacceptable image when output. 

•Midtone

•Shadow

Details in the Shadow
Shadow is the darkest/
blackest area of the image.

•
Highlight
(White)

•Shadow

•Midtone

•Highlight
(White)

Details in the Highlights
Highlights are the lightest
detail in the image.

•
Highlight
(White)

This will flatten Highlights
Midtone is the tonal range between
highlights and shadows.

•
Shadow
(Black)•

Midtone
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Dot gain is the change in size of the printed dot. Dot gain
is defined as an additive percentage so the increase of the
dot size from 50% to 60% is called 10% gain. It should
also be noted, at this point, that the ink jet printer uses a
dithered (stochastic) dot. 

You must remember when working with Dot Gain curves
the higher the number the darker your output will
print.  As an example the 50% box represents the 50%
dot area. If you type 60 in that box your image will print
10% darker. Notice, when moving the curve, that sur-
rounding percentages are also adjusted to blend properly.

Before working with calibration the following should
be considered:

1. The monitor should have been on for at least 1/2 
hour so that the monitor stabilizes.

2. Make sure that the room light you are using during 
calibration is the same light you will be using to 
view the printed images.

3. Turn off Desktop Patterns. A light gray background 
is the best color to use when calibrating.

4. Create a test CMYK file to be used when doing cal-
ibration testing. This file should contain a good rep-
resentation of the CMYK colors in a number of dif-
ferent percentages of color. When printing this test 
file, make sure that you do your calibration with the 
paper and the resolution that you are going to be 
printing your images with.

Using PowerRIP 2000 Calibration

Note:  It is assumed that PowerRIP 2000 is launched and
that the PowerRIP 2000 Main Control Panel dia
log has been maximized.

1. Go to Input>Folder Scanners. The Folder
Scanner Configuration dialog will display.

2. Select Use Calibration in the bottom left corner of
the Folder Scanners Configuration dialog. Adjust 
Calibration will display on the bottom right of the
dialog.

3. Click Adjust Calibration. The Q-Curve 5.0 dialog 
will display.
• Reset: Click Reset when you want to return to the

default curve

•
Highlight
(White)

•
Midtone

This will flatten the shadows.

•
Highlight
(White)

•
Midtone

•

Less Contrast This will flatten the highlights.
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• Cancel: Click Cancel to exit the Q-Curve 5.0 
dialog.

• Save As: After you have created a customized file 
click Save As to save the file for future use. The 
Save As dialog will display. Give your calibration 
file a name and click Save.

Note: You should have created a folder on your hard 
drive to store your customized calibration files. 
It is not wise to save your calibration files in the 
PRPC2000 folder. If you upgrade or uninstall 
and reinstall you could lose your customized cal-
ibration files.

• Load: When you want to use one of your cus-
tomized files you need to tell PowerRIP 2000. 
When you click on Load the Open dialog will dis-
play. Navigate to your calibration folder, highlight 
the calibration file you want to use and click 
Open.

• All Same: If you select All Same all 4 channels, 
Cyan, Magenta, Yellow, and Black will have the 
same curve.

• Channel: Using the Channel pull down you can 
select one channel, Cyan, Magenta, Yellow, or 
Black, and create a calibration file for that channel 
only.

The percentages available are 0 through 100%. You can
not define a negative percentage (less then 0) or more than
100%. You can either type the percentage you want in a
specific box on the right of the Q-Curve dialog or you can
drag the curve. If you drag the curve the percentages will
change in the percentage boxes to match the new curve.

After you have created your customized calibration file
click the Load button so that PowerRIP 2000 knows that
is the calibration file you wish to use. Then click OK to
exit the Q-Curve dialog. As long as Use Calibration is
selected in the Folder Scanners Configuration dialog the
calibration file you loaded will be used. Click OK to exit
the Folder Scanner Configuration dialog. Minimize your
PowerRIP 2000. You are now ready to print using your
customized calibration file.

ColorSync Support
ICC profiles are color space definitions. The ICC profile
format is defined by the International Color Consortium
as a cross platform standard. The ability to cross platform
allows you to print from the PC to Macintosh, or the
Macintosh to the PC. ICC compliant applications, such as
Photoshop 5.x, Illustrator 9.x, or Quark,XPress 4.x have

the capacity to output using ICC profiles. PowerRIP
2000 can print from any ICC compliant application.

Installing the ICC Profiles
PowerRIP 2000 comes standard with ICC profiles for all
printers that PowerRIP 2000 supports. They can be found
in the ICC folder on the PowerRIP 2000 CD. These ICC
profiles have been specifically created for the PowerRIP
2000. If you are using Windows 2000 the ICC profiles
must be installed in the WINNT\System32\Color fold-
er. If you are using Windows 98 the ICC profiles must be
installed in Windows\System\Color folder.

1. The files in the ICC’s folder are executable. Put the
PowerRIP 2000 CD in the CD-ROM drive. Open 
the ICC folder.

2. Double click on the executable for your printer.

3. The WinZip Self extractor dialog will display. You 
have to point the ICC profiles to the Color folder 
using the Unzip to folder portion on the dialog. 
Click Browse. Navigate to the Color folder. Click 
OK.

4. The correct path will display in the WinZip dialog.
Click Unzip. The file will unzip into the Color fold-
er. When finished a dialog will display saying the 
Unzip was successful. Close the WinZip dialog.

You now have the ICC profiles for your printer installed
on your system and ready to be used by your applica-
tions. Refer to the ICC ReadMe on the PowerRIP 2000
CD, in the Docs folder, for an in-depth discussion of the
use of ICC profiles in your applications.

Maximum Density for Color
PowerRIP 2000 has been designed to allow users to print
up to 300% maximum color from CMYK files.
Exceeding this number will cause problems with excess
ink. Some desktop drawing applications set black to
400% by default. A black of 400% wastes ink and is too
dense to print well on printers and large commercial off-
set presses. Most magazines’ printing standards, depend-
ing on the publication and stock, only allow maximum
black within a range of 260% to 285%.
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Chapter 8 includes system requirements for all supported printers.

Printer

Epson Series
Epson Stylus Color, Color II, Color IIs,
400, 500, 600, 640, 660, 740, 760, 800,
850, 860, 900, 1160, 1500, 1520, 3000
Epson Stylus Pro, Pro XL, Pro XL+,
5000, 777, 880, 980

Epson Stylus Photo, Photo EX, 700, 750,
870, 875, 1200, 1270, 2000P
Epson Stylus Scan 2000, 2500, 1290 

Epson Stylus Pro 7000, 7500, 9000,
9500, 5000P

Disk Space

Startup drive should have a mini-
mum of 200 MB of free space for
letter size pages, 280 MB free for
legal size. Complex documents
and large images may require sig-
nificantly more.

2 GB disk space

HP 900 series
(Includes the 930C, 932C, 935C, 950C,
952C, 970Cse, 970Cxi)

HP 1220 series
(Includes the 1220C, 1220Cse, 1220Cxi)

48 MB minimum
(64 MB recommended) 

Startup drive should have a mini-
mum of 200 MB of free space for
letter size pages, 280 MB free for
legal size. Complex documents
and large images may require sig-
nificantly more.

RAM and Disk Space Requirements

RAM

48 MB minimum
(64 MB recommended) 

128 MB minimum

NEC Series
NEC SuperScript PS1260
NEC SuperScript PS870

48 MB minimum
(64 MB recommended) 

Startup drive should have a mini-
mum of 200 MB of free space for
letter size pages, 280 MB free for
legal size. Complex documents
and large images may require sig-
nificantly more.

Operating System Requirements - All Printers

Operating
System

Windows 95/98, NT, Me, Windows
2000 Server & Professional

CD-ROM

Required

PC 
Requirements

Pentium, Pentium II or Pentium III processor (single
or multiprocessor) VGA or SVGA color monitor,
Mouse

Chapter 8 - PowerRIP 2000 System Requirements
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Option Description

Paper Size

Copy Count

Resolution

Scaling

TrueType Font

Color Mode

Rendering Intent

RGB Source

Paper Size should be set to match the paper you have in the printer. The
default setting is Letter.

Select the number of copies you wish to print. The default is 1.

Resolution of the printer is measured in dots per inch (DPI) and represents
the amount of detail that can be shown. The higher the number the finer the
resolution. Lower resolutions print faster and use less ink. The default setting
is 360for most printers.

Scaling allows you to reduce the size of the output to fit within a given paper
size. The default is 100%.

Substitute with Device Font is the default and recommended setting.
Download as Softfont is also available.

Color Mode can be set to either Grayscale or Full Color CMYK. Full Color
CMYK is the default setting.

Rendering Intent should be set to Perceptual. Absolute & Relative Saturation
and Relative & Absolute Colorimetric are not presently available.

RGB Source should be set to reflect the monitor used to create the image.
Use RIP Default if no other option available. RIP Default is the default
setting.

Note: The features discussed in Chapter 9 are dependent on your printer and version of PowerRIP 2000. Not 
all features are available on all printers or on all revisions of PowerRIP 2000.

PowerRIP 2000 Printers

CMYK Source Output profiles for devices such as printers and printing presses. Also know
as destination profiles. CMYK Source should be set to RIP Default

Make Composite from
Separations

Allows you to print composite proofs directly from color separated output
files. Make Composites from Separations should be set to No if you are
printing a composite. Note: Not all applications have the capacity to create
compositions from separations. Photoshop, Word, and Excel are examples of
applications that cannot use this feature.

Print Mode Print Mode can be set to Color-Normal, Color-Draft, Color Best, Color-
PhotoREt, Color-2400x1200, Monochrome-Normal, Monochrome-Draft, and
Monochrome-Best.

Make Separations Make Separations should be set to No unless you are printing a separation.

Chapter 9 - Properties/Features
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PowerRIP 2000 Printers Properties/Features (Cont)

Negative Image

Paper Type

Generate Pure Black

Negative Image should be set to No unless you wish to print a Negative
image.

Paper Type should be set to match the paper you have in the printer.
PowerRIP 2000’s Color Rendering Dictionaries (CRDs) are based upon the
printers special paper stocks. These CRDs produce the maximum output qual-
ity on the selected paper. Paper type is printer and resolution dependent.

Generate Pure Black should be selected if you do not want the black to be
created using C, M, and Y. If Yes is selected blacks will print directly from
the black ink cartridge. If No is selected blacks will be created using C, M,
Y, and K.  Note: Selecting Yes may have an adverse effect on halftones.

Option Description

Screening

Duplexing

Microweave

Print Direction

Screening should be set to Stochastic. Stochastic Screening is a random dot
pattern that produces more tones and has more detail than fixed screen 
rulings.

Select No unless you want to print two sided output. You must have the
Duplex Option.

Microweave is a printing method in which images are printed in finer incre-
ments to reduce the possibility of banding (white lines) and produce laser-like
images. Microweave should be set to On.

Print Direction can be set to Unidirectional or Bi-directional. Bi-directional,
or high speed, is faster and does not significantly decrease print quality.

Nesting Select Pages at 100%, 90%, 80%, 75%, 60%, 50%, 40%, 25%, and 15%.
Pages at 100% will print the pages at full size. Select No Nesting to turn
Nesting off. No Nesting is the default.

Nesting Output Media Size Defines the page size you wish to output your pages on when using the
Nesting feature. Tabloid is the default.

Mirror Image Mirror Image should be set to No unless you wish to print a mirror image.
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Option Description

PowerRIP PDF Properties/Features

PDF Color Appearance SRGB-WEB is the default color space for Windows and the color standard
for the Web. NTSC -1953 is the color standard for national TV. SWOP is the
color standard that all printing presses and proofing systems in the United
States are based on. Select the color appearance that meets you PDF needs.
SEGB-Web is the default setting.

Make Separations Make Separations should be set to No unless you are creating a separation
PDF. You can create separations In Color or In Black. No is the default
setting.

Make Composites from
Separations

Allows you to create a composite PDF directly from a separated file. Make
Composites from Separations should be set to No if you are printing a com-
posite. No is the default setting.  Note: Not all applications have the capacity
to create compositions from separations. Photoshop, Word, and Excel are
examples of applications that cannot use this feature.

Embed All Fonts Select Embed All Fonts to embed all the fonts on your system with the PDF
when it is created. No is the default setting.

Transfer Function Remove will remove the curves when making the PDF. Apply will use the
curves when making the PDF. Preserve will use the curves when creating the
PDF. Apply is the default setting.

Under Color Removal Remove does not preserve UCR when creating the PDF. Preserve retains
UCR when creating the PDF. Remove is the default setting.

Sub-Sample Resolution The available resolutions are 72 dpi, 100 dpi, 150 dpi, 200 dpi, and 300 dpi.
72 dpi is the default setting

Compress Images The available compression methods are No, JPEG Low, JPEG Medium,
JPEG High, and ZIP. ZIP creates the smallest compressed PDF. No is the
default setting.

Preserve OPI Comments Select Yes to retain the information needed to replace a FPO image with a
high resolution image located on a server that supports OPI. No is the default
setting.

Preserve Overprint Settings Select Yes to retain the overprint setting in the file being converted to a PDF.
No is the default setting

Subset Fonts Select Subset Fonts if you have created a list of fonts in Always Embed
These Fonts. The subset you have created will always be embedded with the
PDF when it is created. No is the default setting.

Convert CMYK Images to
RGB

Select Yes if you want RGB images when the PDF is created. No is the
default setting



PowerRIP 2000 ManualiProof Systems, Inc. 38

Device Dependent Color Select Yes to use the PowerPDF 2000 color correction information when
creating the PDF. No is the default setting.

Create Thumbnails Select No if you do not wish to create Thumbnails. Select Color if you wish
to create Thumbnails in color. Select Monochrome if you wish to create
monochrome Thumbnails. No is the default setting.

ASCII Format Select Yes if you want to save the PDF in ASCII Format. No is the default
setting.

CMYK Source The available output profiles include None, RIP Defaults, Japan S, SWOP
Simulated, Normal, Euro LWCP Less Than 70g, Euro Mat Paper Above 70g,
Euro Glossy Paper Above 70g, Euro Uncoated White Offset, and CMYK 1
through 10 which should be used for customized CMYK source information.
None is the default setting.

RGB Source The available monitor profiles are None, RIP Default, a number of Apple
Source Profiles, NTSC-1953, CIE RGB, Generic RGB Profile, Generic LAB
Profile, and REB 1 through 10 which should be used for customized monitor
profiles. None is the default setting.

Rendering Intent Perceptual should be selected. All other selections not available in this
release. Perceptual is the default setting.

Resolution The available resolutions are 72, 144, 288, 300, 600, 1200, and 2400 dpi, 

Mirror Image Select Yes if you wish to create a Mirror Image PDF. No is the default
setting.

Negative Image Select Yes if you want to create a Negative PDF. No is the default setting.

Sub-Sample Image Select No is you do not wish to Sub-Sample. Select Sub-Sample if you wish
the image to be Sub-Sampled or Average if you want the image averaged.

Auto-Rotate Select Yes to rotate the file from portrait to landscape. Select No if you do
not wish to rotate the file. No is the default setting.

Compress PDF Select No is you do not wish to compress the PDF. Select Yes to compress
the PDF.  No is the default setting.

Preserve Halftone Info Select Yes if you want to retain the halftone (screening) information. Yes is
the default setting.

PowerRIP PDF Properties/Features (Cont)

Option Description
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PowerRIP TIFF Properties/Features

Option Description

Make Separations Make Separations should be set to No unless you are creating a separation.
You can create separations In Color or In Black. No is the default setting.

Resolution The available resolutions are 72, 100, 144, 150, 280, 300, 600, 1200, 1270,
2400, and 2540 dpi.

Nesting Select Pages at 100%, 90%, 80%, 75%, 60%, 50%, 40%, 25%, and 15%.
Pages at 100% will print the pages at full size. Select No Nesting to turn
Nesting off. No Nesting is the default..

Nesting Output Media Size Defines the page size you wish to output your pages on when using the
Nesting feature. Tabloid is the default.

Rendering Intent Perceptual should be selected. All other selections not available in this
release. Perceptual is the default setting.

RGB Source The available monitor profiles are None, RIP Default, a number of Apple
Source Profiles, NTSC-1953, CIE RGB, Generic RGB Profile, Generic LAB
Profile, and RGB 1 through 10 which should be used for customized monitor
profiles. None is the default setting.

CMYK Source The available output profiles include None, RIP Defaults, Japan S, SWOP
Simulated, Normal, Euro LWCP Less Than 70g, Euro Mat Paper Above 70g,
Euro Glossy Paper Above 70g, Euro Uncoated White Offset, and CMYK 1
through 10 which should be used for customized CMYK source information.
None is the default setting.

Mirror Image Select Yes if you wish to create a Mirror Image TIFF. No is the default
setting.

Negative Image Select Yes if you want to create a Negative TIFF. No is the default setting.

Make Composites from
Separations

Allows you to create a composite TIFF directly from a separated file. Make
Composites from Separations should be set to No if you are printing a com-
posite. No is the default.  Note: Not all applications have the capacity to cre-
ate compositions from separations. Photoshop, Word, and Excel are examples
of applications that cannot use this feature.

Compression Select No is you do not wish to compress the TIFF image. 

TIFF Color Appearance SRGB-WEB is the default color space for Windows and the color standard
for the Web. NTSC -1953 is the color standard for national TV. SWOP is the
color standard that all printing presses and proofing systems in the United
States are based on.  
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Note: The User Interface information discussed in this chapter is dependent on your printer and version of 
PowerRIP 2000. Not all features are available on all printers or on all revisions of PowerRIP 2000.

PowerRIP 2000 Control Panel Dialog

Main Control Dialog

From this panel you can configure all the default set-
tings of PowerRIP 2000. It is also used to insert manu-
ally, pause, cancel, reprint, and log activities.

Auxiliary Control Dialog

When PowerRIP 2000 is first launched, the Auxiliary
Control dialog is displayed on screen, for a short time,
while the PostScript interpreter is initialized. The
Auxiliary Control dialog disappears and PowerRIP
2000 is automatically minimized to the Windows
TaskBar.

TaskBar

Clicking on the PowerRIP 2000 TaskBar button will
display the Main Control dialog.

• When PowerRIP 2000 detects a PostScript file in its 
queue folder(s), the Auxiliary Control dialog will 
reappear and give you an indication of the current 
activity of PowerRIP 2000.

. • Clicking on the Cancel (bottom right corner of the 

Auxiliary Control dialog) will force PowerRIP 2000
to abort its current process and flush the PostScript 
file back to the queue folder.

• Clicking on the Main Window button (bottom left 
corner of the Auxiliary Control dialog) will close 
the Auxiliary Control dialog and open the PowerRIP
Control Panel dialog.

Toolbar

The Toolbar can be turned on or off in the View menu.
Positioning the mouse pointer over a Toolbar button
will offer pointer-based ToolTips on the button’s func-
tion. An expanded description can be seen in the Status
Bar at the bottom of the PowerRIP window.

Current Process Panel

The Current Process panel indicates the job is current-
ly being processed. Jobs in this panel can be canceled.
Once a job is shown in this panel, changing its printing
attributes is not recommended.

Queued Documents Panel

The Queued Documents panel displays other
PostScript files that have been sent to PowerRIP 2000.
The top file is the one currently being processed. The
other files may be moved in the list, can be deleted,
and can have their printing attributes changed before
they are processed. The options in the Configuration
menu allow these changes to be made. Jobs in this list
that have already been printed may be reprinted.

Status Panel

The Status panel displays messages from the
PostScript  interpreter. Messages in this panel are diag-

Chapter 10 - PowerRIP 2000 User Interface
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nostic in nature, and can help technical support person-
nel identify and correct problems you may encounter
when printing PostScript files.

Status Bar

The Status Bar displays various messages depending
on what the mouse pointer is pointed at. The Status Bar
can be turned off in the View menu.

PowerRIP 2000 Menus and Control Dialogs

File Menu

• Print PostScript File allows you to select for print-
ing a PostScript file not sent directly to PowerRIP
2000, such as a PostScript file created in AutoCAD 
or FreeHand.

• Open/Close Output Log controls the log file of all 
messages PowerRIP 2000 produces and displays in 
the Status Panel of the Main Control dialog. This 
message log can be viewed with any text editor, 
such as NotePad. This option should be invoked 
every time you use PowerRIP 2000.

• Exit shuts down PowerRIP 2000.

Edit Menu
• Cut, Copy, Paste Before, 

Paste After, and Delete. 
All these commands are for 
manipulating individual 
files visible in the Queued 
Documents panel.

View Menu
• Toolbar and Status Bar: 

Selecting either of these items will
hide or show the corresponding 
section of PowerRIP 2000’s Main 
Control dialog.

Input Menu
• Folder Scanners: 

Selecting this item 
opens the Folder
Scanner Configuration dialog.

Folder Settings: This portion controls which queue 
folder PowerRIP 2000 scans for new files, and the 
type of files it scans for.
• The top Add and Remove buttons can add or 

remove folders to the Folders to Scan pull down 
menu. A folder for the PowerRIP 2000 printer you 
selected when installing PowerRIP 2000 is automat-
ically created. If you add another PowerRIP printer 
to your system, you will need to add the directory 
that is created to this menu.

• The lower Add and Remove buttons can add or 
remove file types to the Scan for files with these 
extension pull-down menu.

• Clicking the Advanced button displays the 
Advanced Settings dialog.

• Printer Settings: This section allows you to select 
printers for PowerRIP 2000 to print to, select the 
port, and choose to print with or without Print 
Manager.

• The Use Document Settings button, when 
depressed, tells PowerRIP 2000 to use all the print-
ing options that were selected in the application(s) 
from which the PostScript files were printed.

• The Specify Settings button displays the printer 
Setup dialog.

Note: Most Windows applications allow you to select a 
printer and a PPD, and thus all the options 
included. Use the Use Document Settings option 
when printing from these applications. Some 
applications do not allow the selection of a PPD, 
and thus all the options are not available. Specify
Settings will allow you to set the options as 
desired.

Advanced Setting Dialog
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• This dialog allows you to change how often PowerRIP
2000 scans the selected queue folder, and how many 
times PowerRIP 2000 will scan a new PostScript file 
before beginning to process it.

Note: This last feature can come in very handy when 
printing over a slow or busy network. If a 
PostScript file is incomplete when PowerRIP
2000 starts to process it, it could result in vari-
ous problems. Increasing the value for this fea-
ture can prevent problems from occurring.

• Specify Settings: This dialog allows you to change 
settings for your PostScript files “on the fly.”

• Print Quality tab: 

This dialog allow you to define the Resolution, Print 
Quality, Print Direction, Black Reproduction, Inks, 
and much more.

Note: The features in this dialog are dependent on 
your printer. Not all features are available on 
all printers.

• Color tab:

This dialog allows you to define the Color Mode, 
Color Gamut, Rendering Intent, CMYK Source, and 
RGB Source.

Note: The features in this dialog are dependent on 
your printer. Not all features are available on 
all printers.

• Paper tab:

This dialog allows you to define Media and Image.

Note: The features in this dialog are dependent on 
your printer. Not all features are available on 
all printers.

• Separation tab:

This dialog allows you to define Separated files and 
Composite files.

Configuration Menu
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• Configure PowerRIP 2000: Selecting this command 
opens the Configure PowerRIP dialog, which allows
you to control how long printed PostScript files 
remain available for reprinting, and how many files 
are retained. It also allows you to name your log file 
(You can use any name you wish, but if you add the 
standard .txt extension to the file name, the file can be
opened automatically in NotePad or another text
editor.)

• Configure Document Specs:

Selecting this command opens the Configure 
Document Specs dialog, which allows you to modify 
individual document specifications. Document set-
tings cannot be changed while PowerRIP 2000 is pro-
cessing the file. They can be changed before, or after, 
if you are reprinting a job. This dialog will also 
appear when the Print PostScript File command is 
selected in the File menu.

Note: Many of these options affect the others, and if 
you attempt to use an option that has the sym-
bol xx

x

, a Conflict Window will appear, telling 
you exactly what the conflict is and how to 
resolve it. If you are printing from a Macintosh
workstation, unavailable options will be 
grayed out.
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Chapter11 will explore various troubleshooting options to help you solve problems you may encounter while
installing, setting up, and using PowerRIP 2000 without the need to call on Technical Support. This appendix is
divided into separate sections for troubleshooting PowerRIP 2000 Installation, Testing PowerRIP 2000, Printing to
PowerRIP 2000, and Printing Quality.

Troubleshooting PowerRIP 2000 Installation
This section will help you troubleshoot problems installing the PowerRIP 2000 software.

The PowerRIP 2000 splash screen does
not appear when the CD-ROM is loaded.

Windows reports any kind of non-disk
system error while PowerRIP 2000 is
installing (i.e., a problem not related to
the CD itself).

Windows reports a disk error while
PowerRIP 2000 is installing.

Auto-play is not enabled. You can usually activate the splash
screen by opening My Computer and double-clicking on the CD-
ROM. If it still does not appear, double-click the file Splash.exe
on the CD-ROM.

Restart the computer. When it is finished restarting, disable any
antivirus software, disk compression utilities (e.g., Stacker,
DriveSpace), and Norton Utility.
• If the error persists, write it down and refer to your Windows 

documentation, or visit the Microsoft website’s Support page. 
There is a search function that allows you to enter keywords 
from the error message and receive a list of possible matches 
and solutions.

Your CD may be damaged or dirty. Remove the CD and inspect
the underside of the CD for dust or scratches. If necessary, clean
the CD with a specially-designed cleaning cloth (available at most
computer and music stores). Your computers hard drive may also
be corrupted.

Problem Solution

Troubleshooting, Testing and Printing to PowerRIP 2000
Important: It is highly recommended that you invoke the Message Logging option available in PowerRIP 2000 

(select Open/Close Log in the File menu). This log will help Technical Support personnel identify any 
PostScript problems you may encounter.

Problem Solution

PowerRIP prints on all pages.

When testing PowerRIP, it processes the
pre-made PostScript files, but the printer
only prints strange characters.

Windows displays a message that the
printer is unavailable or not responding,
or the device is not ready

PowerRIP 2000 was not validated. See page 9 of this manual.

This problem usually occurs only in Windows 95/98, when the
BGXXx queue printer cannot be created.

This usually indicates a problem with the physical connection
between the computer and the printer.
• Check all cables for damage, and make sure the connections are

tight.

Chapter 11 - Troubleshooting
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(Continued from previous page)

PowerRIP 2000 cancels jobs without
user interaction or visible alerts.

When printing from my application(s),
the printer starts almost immediately, but
it only prints strange characters.

When printing from a Macintosh or a
Windows workstation to a Windows NT
4.0 PowerRIP 2000 Server, a message
alert appears saying that a file could not
be opened for processing or could not be
deleted.

An on screen message about insufficient
memory appears.

Problem Solution

• If you are using an automatic switchbox, see if there is a manu-
al override to lock in a specific port. If there is, lock in the port
to which your computer is connected.

• If you are using an Ethernet-to-Parallel “bridge,” see if you can
lock in a specific port, or connect the printer directly to the 
computer on which PowerRIP 2000 is installed.

You are probably encountering a PostScript error. Check the
Status Panel of PowerRIP 2000’s Main Control dialog for error
messages, or view the log file in a text editor (the log file is locat-
ed in the PRPC2000 directory on the hard drive.)
• You will probably need to call upon iProof Tech Support to 

identify the error and the cause. iProof Support has a com-
prehensive understanding of the PostScript language and the 
possible errors you can receive.

• Note that many PostScript errors are caused by EPS 
(Encapsulated PostScript) files that are corrupt or incomplete.

PowerRIP 2000 is not processing the file. Make sure that you
selected the PowerRIP 2000 Printer in the applications(s), and the
correct PPD in selected if applicable.

This is either a Sharing problem or a Timeout error. There are
several options you can adjust on both the server and the worksta-
tions.
• On the PowerRIP 2000 Server:

- Increase the PostScript Timeout values in the PowerRIP
2000 Printer Properties dialog, accessed through the 
Printers Control Panel.

- Change the PostScript Output Format to “optimize for porta-
bility” in the Document Properties dialog, accessed as 
above.

- Increase the Timing values in the Advanced Folder Scanner
Settings dialog in PowerRIP.

- Make sure that the Permissions settings for Sharing the 
directory and the PowerRIP 2000 Printer are set to Full 
Access for everyone.

• On the Windows 95/98 workstation:
- Change Data Format in Advanced PostScript Options dia-

log to “Pure Binary.”
• On the Macintosh workstation:

- Check the compatibility of your version of LaserWriter for 
Windows NT 4.0.

Your computer is running out of RAM, or disk cache memory
resources (i.e., virtual memory). Review the System
Requirements in Appendix 1.
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Problem Solution

A message about insufficient memory is
printed in place of or after a job.

Jobs stop printing after a certain time and
the paper is ejected before printing is
complete.

Prints are clipped close to the edges of
the paper.

Fonts appear fine on screen, but are sub-
stituted with another font.

PowerRIP 2000 processes files slowly or
printing takes a long time.

You are running our of free disk space on the boot drive (usually
C:\). Free up memory by deleting unused files and applications,
and defragmenting your hard drive(s).
This message sometimes occurs when printing from FreeHand.
Convert any Spot colors to Process.

This is usually an indication of a lack of free disk space on the
boot drive, or a data transmission error. If you have enough disk
space, check to ensure that another background program (anti-
virus software, disk utility) was not running.

Know what the unprintable area of your printer is and adjust your
documents’ margins accordingly. You can check the unprintable
area values in the PowerRIP 2000 Printer Properties dialog.

This usually indicates a missing or damaged PostScript printer
font, or a damaged TrueType font.
• Check the font downloading options in your application.
• Make sure that ATM can see the PostScript font in question.
• If using QuarkXPress 4.1, turn off ATM, restart your computer, 

turn on ATM, and then launch QuarkXPress. This needs only be
done once to update the .INI files for QuarkXPress.

PostScript interpretation is a processor and disk intensive opera-
tion. If your computer has a slow processor, not enough RAM, or
is running our of free disk space, processing times may be longer
than what you are used to printing directly to the printer. Also,
large or complex documents with many images and graphics will
require more of these resources.

Troubleshooting Print Quality Issues

Obtaining the Best Printing Quality
PowerRIP 2000’s PostScript Level 3 compatible interpreter has the ability to use color rendering dictionaries when
the RIP is driving a color printer. These color rendering dictionaries are automatically accessed by image-manipu-
lation applications like Adobe Photoshop when printing directly to the printer. Images created in Photoshop can be
placed in other applications and still access the color rendering dictionaries, if they are saved as CMYK EPS files
or calibrated RGB EPS files. RGB TIFFs and CMYK TIFFs do not access the color rendering dictionaries auto-
matically if placed in other applications and then printed.

CMYK files are usually created in a device-dependent color space, where you can adjust items to the particular
printing condition of an individual printer rather than accepting the automatic options in a color rendering dictio-
nary.

To obtain high-quality color images, keep the following points in mind:
• Use the supported or manufacturers’ inks and recommended paper for your printer.
• Use the proper papers. Papers designed for ink jet printers have special coatings to evenly distribute the ink, 

and are different than uncoated bond papers used in laser printers and copiers.
• PowerRIP 2000 has balanced the halftone screening and color technology to work with the manufacturers’ inks

and recommended papers.
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Glossary

Several items having special meaning within the context of this manual are listed below:

application Applications are the programs that run on a computer. Some common desktop publishing and
graphics applications are PageMaker an Photoshop.

bitmap Bitmaps are images preprocessed at a fixed resolution for a certain monitor or printer.

CMYK Acronym for Cyan, Magenta, Yellow, and Black (K), the four standard process colors for
printing.

CPU Central Processing Unit, The processor inside the computer. A Pentium is faster than a 486.

dialog A graphic user interface that cannot be resized or minimized or maximized, but can be moved.

EPS Encapsulated PostScript. This is a file type that may contain complex graphics. It is designed as 
a universal format to include complex graphics in other applications.

Image device A device capable of printing an image on a physical medium, for example, a printer, imagesetter,
or ink jet printer.

interpreter A set of software functions to convert PostScript language operators and operands into a raster 
image,

network Cabling, cards, and required software to link computers to each other. Ethernet is the most
common.

PostScript An interpretive programming language, developed by Adobe, used to describe the text, graph-
ics, and image content of a document.

raster image A sequential bitmap composing an image. For each image pixel, there is a corresponding device 
pixel.

render The process by which PostScript language operators and operands are interpreted and a raster 
image is produced.

RAM Random Access Memory. Almost all PCs come with 32 MB as a minimum. You can add more 
RAM to most computers. See your computer dealer for more information.

RIP Raster Image Processor. An application or device that renders images in raster format for an 
imaging device.

SWOP Specifications for Web Offset Printing. All offset press service bureaus use SWOP to match col-
ors. PowerRIP 2000 can adjust colors to simulate SWOP output.

TIFF Tagged Image File Format. This is a standard image file format consisting of labeled fields.

window A graphic user interface that can be resized, minimized, maximized, and moved. It usually 
incorporates scroll bars.
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